Radon Monitor User’s Guide
Accurate, Reliable, Economical
Model 1027
User’s Guide, Continuous Radon Monitor

© Copyright 2017 by Sun Nuclear Corporation. All rights reserved.

The information contained in this manual is copyrighted and all rights reserved by Sun Nuclear Corporation. Copying, duplicating, selling, or otherwise distributing any part of this product without the prior written consent of Sun Nuclear Corporation is prohibited.

Sun Nuclear Corporation reserves the right to make periodic modifications to this document without obligation to notify any person or entity of such revision.

This manual is written for:

Software version: 1.0.0.1

Continuous Radon Monitor™ is a trademark of Sun Nuclear Corporation. Other trademarks or trade names are the property of their respective owners.

Document 102711, Rev H, 28 August 2017
Preface

Description

The Model 1027 Professional Continuous Radon Monitor is an electronic device that uses a diffused-junction photodiode sensor to measure the concentration of radon gas.

The unit is operated using mains power and includes a 9-volt battery for backup power. A numerical display shows the average radon gas concentration.

The Model 1027 has been evaluated and accepted by:
• National Radon Safety Board (NRSB); Device code: 31807; Group Code: CR.
• National Environmental Health Association National Radon Proficiency Program (NEHA-NRPP); Device Code: 223; Group Code: 4.

Health and Safety Instructions

WARNING: To avoid risk of electric shock, this device must only be connected to a supply mains with protective earth (ground).

WARNING: Never use the radon monitor in an area that could contain explosive gases. A spark from inside the device could ignite an explosion.

To protect Continuous Radon Monitor performance and cable insulation, never pull on a cable to disconnect it. Always grasp the plug or connector.

Do not permit water or any other liquids to spill onto the instrument.

For instructions to report health or safety related concerns, see Reporting Health or Safety Related Issues or Concerns on page 36.
1 Introduction

Parts

The following parts are shipped with Continuous Radon Monitor, Model 1027.

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Qty</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>102730 or 102730-RM</td>
<td>1</td>
<td>Model 1027 Professional Continuous Radon Monitor or Model 1027 Professional Continuous Radon Monitor (Refurbished)</td>
</tr>
<tr>
<td>741011</td>
<td>1</td>
<td>Power supply, 18 VDC, 0.3A, 100-240 VAC (not shown)</td>
</tr>
<tr>
<td>801032Z</td>
<td>1</td>
<td>Cable, RS-232 (serial), DB9M to DB9F, 6 ft. (not shown)</td>
</tr>
<tr>
<td>102713</td>
<td>1</td>
<td>Technical Bulletin 12-09, USB Port Troubleshooting (not shown)</td>
</tr>
<tr>
<td>0200014</td>
<td>1</td>
<td>Customer Support site introduction letter (not shown)</td>
</tr>
</tbody>
</table>

Figure 1-1. Parts Furnished with P/N 102700-0 and 102700-0RM

Options and Accessories

The following accessories can be used with the Model 1027.

Table 1. Model 1027 Options and Accessories

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>102750</td>
<td>Portable thermal printer (see Thermal Printer on page 2)</td>
</tr>
<tr>
<td>850029</td>
<td>USB to Serial Adapter</td>
</tr>
<tr>
<td>741012</td>
<td>International blade kit for power supply P/N 741011</td>
</tr>
<tr>
<td>102377</td>
<td>Report, Radon Gas Measurement, blank</td>
</tr>
<tr>
<td>102378</td>
<td>Sign, self-adhesive, “Warning, Closed Building Procedure”</td>
</tr>
<tr>
<td>102379</td>
<td>Sign, plastic, hanging, “Caution, Radon Test in Progress”</td>
</tr>
<tr>
<td>1028130</td>
<td>Sign, vinyl static cling, “Warning, Closed Building Procedure”</td>
</tr>
</tbody>
</table>
Thermal Printer

The optional portable thermal printer, P/N 102750, is used to print reports after measurements. The following parts are included.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>850040Z</td>
<td>Thermal printer, 40 column</td>
</tr>
<tr>
<td>022005Z</td>
<td>Power supply, 6VDC, 2.1 mm plug (not shown)</td>
</tr>
<tr>
<td>801008Z</td>
<td>Mains power cord for power supply, 2.3 m, 125V 5-15 P C13 (IEC Plug to USA style; not shown)</td>
</tr>
<tr>
<td>750052</td>
<td>Rechargeable battery pack, 4.8V Ni-MH</td>
</tr>
<tr>
<td>780374</td>
<td>Connector, gender changer-mini 9 M-M (not shown)</td>
</tr>
<tr>
<td>801032Z</td>
<td>Cable, RS-232 (serial), DB9M to DB9F, 6 ft. (not shown)</td>
</tr>
<tr>
<td>850043Z</td>
<td>Thermal printer paper roll (see Figure 2-2 on page 4)</td>
</tr>
</tbody>
</table>

*Figure 1-2. Optional Portable Thermal Printer, P/N 102750*

*Note:* The impact printer (P/N 020030) offered with earlier Model 1027 Radon Monitors is no longer available. The replacement is the thermal printer described in Figure 1-2.
Unpack

Unpack the shipping box and identify the parts. See Parts on page 1.

Note: Save the packing material if you plan to return the Model 1027 for periodic re-calibrations. See Thermal Printer Maintenance on page 21.

Set Up Hardware

Before collecting data with Model 1027, decide how you want to print reports.

• Using the optional thermal printer, P/N 102750. See Set Up Thermal Printer below.
• Using a printer connected to a laptop or personal computer. This option requires the Radon Monitor software application. See Set Up Software on page 5.

Set Up Thermal Printer

1 Connect gender changer (P/N 780374) to printer serial port.

2 Connect RS-232 (serial) printer cable (P/N 801032Z) to Model 1027 DATA PORT and to printer gender changer.

3 To operate printer on AC power, plug power supply (P/N 022005Z) into printer power connector. Then, plug detachable power cord (P/N 801008Z) into printer power supply and into a mains power source that matches ratings on power supply.

Alternately, operate printer from its rechargeable battery.

Figure 2-1. Printer Controls and Indicators
4 Slide Power switch (on side of printer) to On (I) position (Figure 2-1). Green power indicator turns on and flashes once every second. If battery is low, indicator flashes once every 1/2 second.

WARNING: Do not press and hold ON LINE button and FEED button simultaneously for 30 seconds or more. This resets internal switches and prevents use of the printer.

5 To feed printer paper, toggle ON LINE button to OFF LINE position (red indicator), then press FEED button. It is only possible to feed paper when printer is OFF LINE. See Load Printer Paper below.

6 When printer paper is in position, toggle ON LINE button to ON LINE position (green indicator).

See Table 2 on page 31 for a description of thermal printer indicators.

Load Printer Paper

*Note:* Load thermal printer paper in an area protected from direct sunlight.

1 Unwrap roll of thermal printer paper (P/N 850043Z) and, if necessary, cut leading edge straight across.

![Figure 2-2. Loading Printer Paper](image-url)
2 Open printer paper cover and place roll of thermal paper, edge down, in cover. Printing surface is on inside of roll.

3 Turn on power, then push edge of paper into inlet slot at bottom of paper holder until auto-loader catches paper and feeds about 10 cm through paper cutter. If necessary, keep pressing paper FEED button until paper feeds straight and smoothly.

   **Note:** When paper is loaded correctly, red OFF LINE indicator stops flashing and stays on to indicate printer is still in OFF LINE mode.

**Low Printer Battery Indication**

When POWER (green) indicator starts flashing once every 0.5 seconds and printer goes OFF LINE (red indicator), connect AC adapter.

If any data is in the memory buffer when POWER indicator starts flashing, connect the AC adapter as quickly as possible to prevent data loss, then push ON LINE button.

**Set Up Software**

**Prerequisites**

- Ensure the computer meets the system requirements in *Recommended System Requirements* on page 34.
- Administrative rights may be required to install and use the software, and to set up communication between the computer and the Radon Monitor.

**Install Software**

1 Download the 1027 Radon Monitor software from the Radon Support website, [https://support.sunnuclear.com/radon/](https://support.sunnuclear.com/radon/) and save it to your computer or laptop.

2 Run the executable file, `Radon1027_v<X>.exe` and follow the on-screen instructions to install the software.

   Radon 1027 icon appears on the desktop.

**Set Up Communication**

Model 1027 ships with an RS-232 cable (P/N 801032Z) that connects to a computer’s serial (COM) port. This connection allows data transfer from Model 1027 to a computer, where you can view, edit, and print reports.

Newer computers have USB ports instead of serial ports. In this case, an optional *USB to Serial Adapter* cable is used to connect Model 1027 to the computer. A typical adapter has a short cable with a serial connector on one end, a USB connector on the other end, and a small circuit board molded to the connector.
To connect Model 1027 to a computer using a serial port and the RS-232 data cable, see *Using Serial Port* below.

To connect Model 1027 to a computer using a USB port, see *Using USB to Serial Adapter* on page 7.

**Using Serial Port**

1. Connect one end of RS-232 data cable to Model 1027’s **DATA PORT** and other end to computer’s serial (9-pin) **COM** port (Figure 2-3).

![Figure 2-3. Connecting Radon Monitor to Computer with RS-232 Serial Cable](image)

2. Double-click the **Radon 1027** desktop icon to start the application.

   If the icon is not visible:
   
   - Click **Start > Programs > SNC Group > Radon 1027**
   - Navigate to the folder where the program is installed (for example, **C:\Radon**) and double-click the **Radon.exe** file.

Application opens with a blank screen (Figure 2-4 on page 7).

On menu bar, **Get Data** menu option is dimmed because a Com Port has not been selected. Model 1027 can use Com port 1, 2, 3, or 4.
3 On computer where RS-232 cable is connected, check connector to identify Com port number.

4 Click **Com Port** on menu to display available Com Ports. Unavailable Com Ports are dimmed.

5 Select **Com Port** on computer to which RS-232 cable is connected. A bullet appears next to selected port (Figure 2-5).

![Figure 2-4. Application Opens With Blank Screen](image)

**Using USB to Serial Adapter**

Sun Nuclear has tested and approved the IOGEAR Model GUC232A USB to Serial Adapter (Figure 2-6 on page 8). This adapter can be purchased directly from Sun Nuclear by ordering P/N 850029, or can be purchased at a computer store, office supply store, or from an internet supplier.

![Figure 2-5. Select the Desired Com Port](image)

If you accidentally selected the wrong port, select the correct port.
Although it is possible to use a different USB to Serial Adapter, doing so is not recommended because other USB to Serial Adapter installations have not been tested. USB to Serial Adapters require special installation procedures, and each manufacturer supplies specific instructions.

System Requirements
- The IOGEAR Model GUC232A USB to Serial adapter can be used with a computer running any of the supported operating systems for the Radon Monitor. See Recommended System Requirements on page 34.
- Administrative rights may be required to install the adapter drivers.

Adapter Installation
The following items are required to perform this procedure:
- IOGEAR Model GUC232A USB to Serial Adapter.
- CD and manufacturer’s instructions provided with USB to Serial Adapter. Updated adapter drivers can also be downloaded from the IOGEAR website. See Updating USB to Serial Adapter Drivers on page 25.
- RS-232 cable included with Model 1027.

CAUTION: Sun Nuclear will only provide technical support for the IOGEAR Model GUC232A adapter.

CAUTION: Retain CD and manufacturer’s instructions for adapter. CD and instructions are needed to install of adapter drivers.

1. Connect RS-232 cable from Model 1027 DATA PORT to serial connector on USB to Serial Adapter (Figure 2-7).
2. Plug USB connector on other end of USB to Serial Adapter into a USB port on computer.
Insert manufacturer’s CD into computer’s CD drive, or open downloaded driver file, and follow the manufacturer’s on-screen instructions. Normally a CD drive is set for Autostart and the installation program opens automatically. If it does not, depending on your Operating System, use My Computer, Windows Explorer, or File Explorer to navigate to the CD and manually start the program following the manufacturer’s instructions.

**Verify Driver Installation**

1. To verify USB to Serial Adapter drivers were installed correctly, open 'Device Manager' on your computer and check the COM port connection. If you are not sure how to open your computer’s Device Manager, follow the instructions below for your Operating System.

   - **Windows 10:** Right-click the Start button, then select Device Manager from the context menu.
   - **Windows 8.1:** On the desktop, right-click This PC icon, select Properties to display the ‘System’ window, then click Device Manager to display a list of devices. Or, right-click Control Panel, and in the ‘Control Panel’ window, click Hardware and Sound > Device Manager to display a list of devices.
   - **Windows 7:** On the desktop, right-click My Computer, select Properties to display the ‘System Properties’ window, click the Hardware tab, then select Device Manager. Type a password or provide confirmation if prompted to do so. Or, click Start > Control Panel > Device Manager.
2 In ‘Device Manager’ window, expand **Ports (COM & LPT)** to see a list of connected ports.

In Windows 10, if **Ports (COM & LPT)** does not appear in the list, in ‘Device Manager,’ click **View > Show hidden devices**.

3 In the Ports list, look for a port labeled **ATEN USB to Serial Bridge (COM#)** if using recommended IOGEAR USB to Serial adapter. (Look for something similar to **USB Serial Port (COM#)** if using a different adapter.)
4 Verify the port is correct by disconnecting and then reconnecting USB end of cable from computer. Port should disappear from list and then reappear.

If no port disappears and reappears when you disconnect and reconnect the cable, the computer does not recognize the USB to Serial Adapter. Reinstall drivers provided with USB to Serial Adapter, and then try this procedure again. (See also Troubleshooting USB to Serial Adapter on page 25.)

5 Make note of serial port number (COM port) of USB to Serial adapter. You will need this to set the Radon Monitor application to connect to this port.

Set COM Port in Radon Monitor Software

1 After USB to Serial Adapter is successfully installed, power up Model 1027 and launch Radon Monitor application.

2 On menu, click Com Port and select Com port number set up in previous section for USB to Serial Adapter.

![Figure 2-10. Selecting Adapter Com Port in Radon Monitor Application](image)

**Note:** Radon Monitor application only recognizes Com ports 1, 2, 3, or 4. Ports dimmed on menu are not available.
3 Operation

Set Up

CAUTION: Do not use in outdoor environments. Humidity and extreme temperatures will cause measurement errors.

CAUTION: Do not allow cell phones within 10 feet of the Model 1027 if the cell phone is turned on and the Radon Monitor is actively acquiring measurements. Cell phone signals can cause readings that are higher than the actual radon measurement.

1 Unpack Model 1027 and place in position within space to be monitored for radon gas. The device does not need to be level.

2 Avoid using switch-controlled outlets. Plug power adapter into power input jack on Model 1027 (Figure 3-1), then plug power adapter into a mains power wall outlet that matches power ratings printed on power supply.

Figure 3-1. Connecting Power to Model 1027

- Green POWER LED turns on.
- Yellow LED flashes twice followed by a single flash to indicate Model 1027 has performed all internal diagnostics and is functioning properly.

3 Insert TOP PANEL key and turn to ENABLE position to activate top panel controls.
Press AVG button. If memory is clear, three decimal points appear in display. If memory is not clear, long term average radon concentration is displayed. In this case, you must clear memory before collecting measurements.

**Clear Memory**

1. Press and hold both buttons on top of Model 1027 until yellow LED turns on, then release both buttons. Yellow LED flashes.
2. While yellow LED is flashing, press and hold CLEAR button. Yellow LED initially turns off; then turns on solid, not flashing.
3. Release CLEAR button when yellow LED turns on solid.
4. When yellow LED and display LEDs flash, followed by a single flash of yellow LED, memory is cleared.

*Note:* When Model 1027 is powered on, a tamper sensor is always active except for a 15-second period immediately following a CLEAR memory procedure. To avoid a tamper notation on the first reading, do not move Model 1027 once the tamper sensor is active.

**Conduct Test**

1. If desired, switch on backup battery. A fresh battery provides about 20 hours of back-up operation.
2. Turn TOP PANEL switch to DISABLE, then remove key.

*Note:* To test tamper sensor, CLEAR memory and conduct a test for several hours. During the test, try lifting or sliding Model 1027. In the printed results, a “T” should appear in the interval when the disturbance was made.

3. At end of monitoring period, insert TOP PANEL key and turn to ENABLE.

**Display Results**

1. Press AVG to display the average radon concentration in pCi/l over the total monitoring period.
2. Press CUR to display the radon concentration in the current 12-hour period.
To print results, review Delayed Results below before proceeding to Reports on page 16. Or, record results on a piece of paper for a handwritten report.

## Delayed Results

Test results can be displayed, printed, or downloaded later or at another location, provided you understand the following differences:

- When power is disconnected, the value of the latest partial interval and the CUR value are lost from temporary memory.
- When power is on (including battery power) Model 1027 continues to operate, providing values that are averaged into the result.
- If you take an AVG reading, disconnect power, restore power later and take a second reading, the second AVG reading may be slightly different from the first reading. This is because the first AVG reading includes the value for the partial one hour interval in process. This partial value is stored in temporary memory and is lost when power is disconnected.

This second AVG value is calculated using only completed intervals stored in non-volatile memory.

## Interpreting Results

The Model 1027 radon monitor is calibrated by setting internal switches to determine the calibration J-factor, which provides the conversion between counts per hour and pCi/L for that Model 1027. A separate calibration factor is also calculated and printed on the calibration report.

The Model 1027 automatically multiplies the hourly measurements by the J-factor to yield the actual pCi/L to within 5%, and then displays these results on the printed report.

To improve accuracy, the user can manually multiply the measurement results by the calibration factor that is listed on the calibration report for the Model 1027.

The measurement results on the printed report are calculated as follows:

- The hourly measurements are the number of counts recorded during that hour, times the J-factor, rounded to the nearest 0.1 pCi/L.
- The Overall Average is the number of total counts, divided by the number of hours, times the J-factor, then rounded to the nearest 0.1 pCi/L.
- The EPA Protocol Average is calculated the same as the Overall Average, excluding the first four hours of measurements.

Note that the average of the displayed hourly measurements and the reported averages may not be the same. This is due to differences in the rounding. As described above, the displayed hourly measurements are rounded each hour,
while each average is only rounded once. The reported average is thus a more accurate measurement than averaging the displayed hourly measurements.

If the EPA Protocol Average is close enough to the 4.0 pCi/L EPA threshold that rounding is a possible issue, additional radon measurements should help to determine the actual radon level.

**Shutting Down**

1. Unplug power adapter from mains power.

![CAUTION: Switch off backup battery. When backup battery is on, Model 1027 continues to operate.]

2. Switch off backup battery to avoid measurement interference with completed test and to prevent battery depletion.
Thermal Printer Reports

Figure 4-1 shows measurement results displayed in a sample typical thermal printer report.

Information to be filled in by testing professional.

“T” (tamper) - Indicates movement occurred during this interval. The unit may have been moved during the test.

“P” (power) - Indicates power interrupt during this interval. The unit may have been moved during the test.

TABULAR DATA - Average radon gas concentration during each measurement interval is printed in sequential order; reading in rows from left to right up to a maximum of 90, 1-hour measurement intervals.

Overall Avg. - Long term average since last memory CLEAR.

EPA Protocol Avg. - Long term average less the first 4 hours of data.

Measurement Graph - Each radon concentration value is graphically represented in the same order as the tabular printout. Scale is automatically adjusted to show maximum value in pCi/l.
To print a thermal printer report:

1. Ensure Model 1027 and printer are powered up and connected (see Set Up Thermal Printer on page 3), and a minimum of three hours of data has been collected.

2. Press and hold both buttons on top of Model 1027 until yellow LED turns on solid, then release buttons. Yellow LED flashes.

3. While yellow LED is flashing, press and hold PRINT button until yellow LED turns on solid, not flashing.


5. When yellow LED flashes once, data transfer is complete.

**Computer Reports**

**Prerequisites**

Before creating or printing reports with a computer:

- Communication between Model 1027 and the computer must be set up. See Set Up Hardware on page 3.
- Radon Monitor software application must be installed. See Set Up Software on page 5.

**Set Up Report Information**

If desired, before transferring data from Model 1027 to a computer, configure header and footer information to be automatically added to each report. This information must be entered before data is transferred.

1. Launch Radon Monitor application, then select *Edit > Info* to open ‘Information Setup’ dialog box (Figure 4-2).

   ![Figure 4-2. Information Setup Dialog Box](image)

   - Mark checkbox to add info to report
   - Enter S/N and click arrow to add to list
   - Info added to report header
   - Info added to report footer
   - Test Start and End dates and times
   - S/N of Model 1027 used in test
   - Test location
2 Mark Enable Info checkbox, then enter desired information.
   See Table 3, Radon Monitor Report Information, on page 32 for additional
   instructions on completing the fields.
3 Click OK, then proceed to Transfer Data below.

**Transfer Data**

*Note: At least three hours of data should be accumulated before
transferring data.*

1 Ensure Model 1027 is powered on and connected to computer. (See Using
Serial Port on page 6 or Using USB to Serial Adapter on page 7.)
2 Launch Radon Monitor application.
3 Verify proper Com port is selected. (See Set COM Port in Radon Monitor
Software on page 11.)
4 Optionally, add report information. (See Set Up Report Information on
page 17.)
5 Click Get Data.
   Message “Listening for data on Com X...” displays at bottom of screen.
6 On top of Model 1027, press and hold both buttons until yellow LED lights
solid, then release both buttons. Yellow LED flashes.
7 With yellow LED flashing, press and release Print button to transmit data.
   Message at bottom of screen displays “Acquiring data on Com X, please
wait...”.
8 When data transfer is complete, report displays (Figure 4-3).

![Figure 4-3. Report Displayed in Editing Screen](image)
• ‘Acquiring Data...’ message indicates computer is able to communicate with Model 1027 via selected Com port.
• If “Index out of bounds” message is displayed after pressing Print button, Model 1027 does not have sufficient test data.

**Edit and Print Reports**

The central part of the Radon Monitor application screen is an editing window. Text can be added, deleted, or changed in any part of the report using standard Windows keystrokes to enter or delete characters. Use scroll bars to view other parts of report.

- On the **Edit** menu, use **Cut**, **Copy**, and **Paste** to make changes.
- To interpret report results, see Figure 4-1 on page 16. Data between the header and footer in the editing screen is the same as is printed on thermal printer paper.
- To print the report, select **File > Print** and in the dialog box, click **OK**.

**Save Reports**

Reports can be saved in two formats:

- ASCII text format (“Text Files”). The suffix “.t” is appended to the file name.
- Tab-delimited format suitable for importing into a spreadsheet, such as Microsoft Excel. The suffix “.s” is appended to the file name. In this format, numerical values are placed in individual cells, which allows the use of graphing functions and other spreadsheet tools.

1. On **File** menu, click **Save As**. ‘Save As’ dialog box opens (Figure 4-4). By default, files are saved in **C:\Radon\Data** subdirectory. You can save files here, or select a different folder.

![Figure 4-4. Save As Dialog Box](image)

2. Use **Save as Type** drop-down list and select format type.

3. Enter a **File Name**. Use a naming scheme suitable to your purpose, such as client name, address, date, serial number, or some combination. The appropriate suffix is added automatically depending on the selected file type.

4. Click **Save**.
5 Support and Maintenance

Maintaining Hardware

Repairs

WARNING: Model 1027 contains high-voltage circuits. Do not open the case. There are no user-serviceable parts inside the device.

If there are problems with the device, contact Sun Nuclear Support. See Contacting Sun Nuclear Support on page 28.

Inspection

Inspect the device and all cables for physical damage before and after each use. Do not use any cable that is damaged or has broken insulation. Replace the cable immediately. If any device damage, mechanical or electrical degradation, or measurement errors are suspected, contact Sun Nuclear Corporation for repair or replacement.

Storage

Store the Radon Monitor in an indoor, protected environment. Do not store the device in the trunk of a car for extended periods. Keep the device dry.

Cleaning

Clean the unit with a soft dry cloth. Do not use liquid cleaners, solvents, or abrasives.

Disposing and Recycling

The instrument contains electrical components. In some countries the disposal of electrical components is subject to special requirements. When the components are no longer functional or are otherwise ready to be discarded, recycle or dispose of them according to local waste management or recycling regulations.

Service and Calibration

The recommended calibration frequency for Model 1027 is one year. For service or calibration, the Model 1027 must be returned to Sun Nuclear Corporation. See Contacting Sun Nuclear Support on page 28.
Changing Backup Battery

To change Model 1027 backup battery:

1 Pull out on one end of hinged battery compartment door (Figure 5-1).
2 Remove battery from connector, install a new 9V alkaline battery, and close battery compartment door.

![Figure 5-1. Changing Model 1027 9V Backup Battery](image)

Thermal Printer Maintenance

Rechargeable Battery Pack

The thermal printer’s battery pack (P/N 750052) allows report printing without AC power. The battery pack is automatically recharged when AC power is connected.

Charging Battery Pack

*Note: Always charge the battery in 5 to 40 °C (41 to 104 °F) temperature range, to avoid degrading battery pack.*

1 Turn power off.
2 Connect AC adapter to printer. POWER light flashes once every second while battery is charging. It takes about 10 hours to completely recharge.
3 When POWER light stops flashing and turns off, battery is fully charged. Disconnect AC adapter.

Inserting Battery Pack

1 Turn printer over and slide battery cover away from battery pack enclosure. See Figure 5-2 on page 22.
2 Connect battery pack connector to printer connector.
3 Turn battery pack so label is visible, insert in printer, and close battery cover.
Removing Battery Pack

1. Turn printer over and slide battery cover away from battery pack enclosure.
2. Pull out battery pack, grasp connector with thumb and index finger, and disconnect battery pack.
3. Close battery cover.

Efficient Printer Battery Use

Battery efficiency decreases if the battery is recharged more than necessary. Confirm whether POWER light is flashing and battery charge has decreased before recharging battery.

When using the rechargeable battery, turn off the power switch after use. Leaving the power switch on will consume battery and eventually run the battery down.

When using the AC adapter, note that the battery gradually recharges whether the printer is on or off. It takes about 15 hours to charge the battery with the power on. Battery charging is temporarily disrupted while the printer is printing and resumes when printing is completed. When not using the printer, turn off the power switch and unplug the AC adapter.

Printer DIP Switch Settings

The thermal printer (P/N 850040Z) has internal DIP switches set by the manufacturer. For proper operation, these switches must be set as shown (Figure 5-3). Check and, if necessary, set the switches as follows:
1. Slide power switch to OFF position (0), then slide power switch to ON position (1) while pressing and holding the **ON LINE** button.

2. Release the **ON LINE** button after the list of current DIP switch settings (Figure 5-3) begins to print. When the list of settings is complete, a prompt appears at the bottom of the printout:

   "Continue? : Push On-line SW"
   "Write? : Push Paper feed SW"

3. To leave DIP switch settings the same, push the **FEED** button.

4. To change any DIP switch settings, push the **ON LINE** button. The prompt "Dip SW-1" appears on the printout below the current settings.

---

**Figure 5-3. DIP Switch Settings for Printer**

- Dip SW-1
  - 1 (OFF) : Input = Serial
  - 2 (ON) : Printing Speed = High
  - 3 (ON) : Auto Loading = On
  - 4 (ON) : Auto LF = On
  - 5 (ON) : Setting Command = Enable
  - 6 (OFF) : Printing
  - 7 (ON) : Density
  - 8 (ON) : = 100 %

- Dip SW-2
  - 1 (ON) : Printing Columns = 40
  - 2 (ON) : User Font Back-up = ON
  - 3 (ON) : Character Select = Normal
  - 4 (ON) : Zero = Normal
  - 5 (ON) : International
  - 6 (ON) : Character
  - 7 (ON) : Set
  - 8 (OFF) : = USA

- Dip SW-3
  - 1 (ON) : Data Length = 8 bits
  - 2 (ON) : Parity Setting = No
  - 3 (ON) : Parity Condition = Odd
  - 4 (OFF) : Busy Control = XON/XOFF
  - 5 (ON) : Baud
  - 6 (OFF) : Rate
  - 7 (ON) : Select
  - 8 (OFF) : = 1200 bps

Continue? : Push 'On-line SW'
Write? : Push 'Paper feed SW'

DIP SW setting complete!!
5 Set each of the eight switches in DIP SW-1 by pressing either **ON LINE** for “on” or **FEED** for “off.” As each switch is set to ON or OFF, printer prints the selection. When switch 8 is set, printer once again prompts with “Continue?” or “Write.” Press **ON LINE** switch to “Continue to SW-2.”

**CAUTION:** Never turn the printer power off while writing the new settings to memory. When “Dip SW setting complete” is printed, turn the power off.

6 In same manner, set DIP switches for SW-2 and SW-3.

7 When SW-3 is finished, press **FEED** to select “Write.” Changes are written to printer memory, and printer returns to **ON LINE** mode.

**Troubleshooting**

**Troubleshooting Model 1027**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Probable Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average measured value is higher or lower than expected and a change in hourly readings occurred mid-report</td>
<td>Count number of hourly measurements and compare with number of hours Model 1027 was deployed. If number of hourly measurements is greater than number of hours deployed, memory was not properly cleared before testing. Previous measurements are being averaged in with data from current test.</td>
<td>CLEAR memory and re-test. See <em>Set Up</em> on page 12.</td>
</tr>
<tr>
<td>Model 1027 has an AVERAGE value, but no CURRENT value</td>
<td>Model 1027 has lost power recently, which cleared CURRENT value. However AVERAGE is maintained until it is deliberately CLEARED.</td>
<td>Re-test.</td>
</tr>
<tr>
<td>“Index out of bounds” message displays after pressing PRINT</td>
<td>Not enough data collected.</td>
<td>Accumulate at least three hours of data before transferring to computer.</td>
</tr>
<tr>
<td>Battery is dead</td>
<td>Battery switch was left on when mains power was removed and Model 1027 continued to monitor until battery was depleted.</td>
<td>Replace battery.</td>
</tr>
<tr>
<td>Report states “NO DATA” after a test</td>
<td>Model 1027 did not have power.</td>
<td>• Re-test in location with known reliable power. • Ensure battery is fresh, battery switch is ON, and POWER LED is ON.</td>
</tr>
</tbody>
</table>

*Note: All eight SW-1 switches must be set to on or off before exiting. Do not exit in the middle.*
Troubleshooting Thermal Printer

<table>
<thead>
<tr>
<th>Problem</th>
<th>Probable Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow LED flashing continuously</td>
<td>Model 1027 has failed.</td>
<td>Contact Sun Nuclear.</td>
</tr>
<tr>
<td>HV OFF LED on continuously</td>
<td>High Voltage supply is off. Model 1027 has failed.</td>
<td>Contact Sun Nuclear.</td>
</tr>
</tbody>
</table>

Troubleshooting USB to Serial Adapter

<table>
<thead>
<tr>
<th>Indication</th>
<th>Probable Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can’t find manufacturer’s CD or drivers</td>
<td>Lost or discarded</td>
<td>Download from manufacturer’s website</td>
</tr>
<tr>
<td>Yellow exclamation point or question mark next to USB to Serial Adapter in Device Manager</td>
<td>Incorrect installation</td>
<td>Reinstall drivers per manufacturer’s recommendations.</td>
</tr>
<tr>
<td>Warning message that Com port is in use</td>
<td>Conflict with another serial device</td>
<td>Disconnect the other serial device; disable HotSync or ActiveSync; reinstall USB to Serial Adapter.</td>
</tr>
<tr>
<td>Installation assigns Com port to number higher than 4</td>
<td>Other serial devices installed</td>
<td>Un-install one serial device installed in Com ports 1 through 4 and reinstall USB to Serial Adapter.</td>
</tr>
<tr>
<td>Radon Monitor software does not download data</td>
<td>Wrong Com port selected</td>
<td>Select correct Com port.</td>
</tr>
<tr>
<td></td>
<td>Data not sent from Model 1027</td>
<td>Select Get Data on menu, press AVG and CUR buttons on Model 1027 simultaneously, release when yellow LED solid; press PRINT button when LED is flashing.</td>
</tr>
</tbody>
</table>

Updating USB to Serial Adapter Drivers

If the CD included with the USB to Serial adapter does not provide the correct drivers for your operating system, or to check whether newer drivers are available, visit the adapter manufacturer’s website and download the latest drivers for your operating system.

For the recommended USB to Serial RS-232 Adapter (IOGEAR Model GUC232A, Sun Nuclear P/N 850029), go to the IOGEAR website (www.iogear.com) and download the latest drivers using the following steps.

1  Click Support link and then select Drivers/Manuals.

2  In ‘Search for your product’ box, select Driver radio button and type GUC232A in text box. A link to driver is displayed.
3 Click link below search box to display a list of available drivers, then click **Download** link for your operating system.

*Note: Vista 64-bit drivers are not supported by Radon Monitor.*

4 In ‘File Download window,’ click **Save**, and save file to your hard drive. If downloaded file is compressed (*.zip or *.rar format), use an unzip utility to extract contents. Make note of where file is saved/extracted.

5 Disconnect and then reconnect USB end of adapter from computer. ‘Found New Hardware Wizard’ is displayed.

6 Click **Locate and install driver software (recommended)**. If Windows requests permission to continue, click **Continue**. Windows may search for drivers online and install them if it finds them. Otherwise, continue.

7 If ‘Insert the disc’ dialog box opens, click **I don’t have the disc. Show me other options**.

8 If Windows can’t find the driver software, click **Browse my computer for driver software (advanced)**.

9 When prompted for driver location, click **Browse** and navigate to directory where you saved/extracted driver files. If files are in subfolders for several operating systems, choose correct subfolder for your operating system.

10 Click **Next** to install driver. When driver is installed, screen shows that the software for the USB to Serial Adapter was successfully installed.

11 Click **Close**.

**Troubleshooting Data Download Issues**

The steps in this section are for users who have already followed the procedures in *Using USB to Serial Adapter* on page 7 and have 1) already connected a USB to Serial adapter, 2) installed drivers for the adapter following the cable manufacturer’s instructions, and 3) are still unable to download data from Model 1027 to the computer.

Typically, the inability to download data from Model 1027 is caused by the Com port number assigned to the adapter. The Radon Monitor software only recognizes Com ports 1 through 4, so if the cable uses Com port 5 or higher the software will not recognize the cable. Perform this procedure to change the Com port assignment to 4 or lower.

*Note: To use this procedure you may need to be logged in to the computer as an administrator.*

1 Turn Model 1027 OFF and exit Radon Monitor software.
2. Open ‘Device Manager’ and in ‘Device Manager’ window, expand PORTS. (For instructions see Verify Driver Installation on page 9.)

3. In Ports list, if using recommended IOGEAR USB to Serial Adapter look for port labeled **ATEN USB to Serial Bridge (com#)**. Look for something similar to **USB Serial Port (com#)** if using a different USB to Serial Adapter cable.

4. Verify this is correct port by disconnecting and then reconnecting USB end of cable from computer. Port should disappear from Ports list and then reappear. If none of ports disappear and reappear with above test, computer does not recognize USB to Serial Adapter. Reinstall drivers provided with adapter and then try this procedure again. See Adapter Installation on page 8.

5. Double-click Port to open Com Port Properties.

6. Click **Port Settings** tab, then **Advanced** to display ‘Advanced Settings’.

7. Click drop-down list with Com port number in it. Ports that are not available are labeled “in use”.

8. Select available port 1, 2, 3, or 4.

   **CAUTION:** If ports 1 through 4 are labeled “in use”, all ports may be assigned to a connected device OR to software for a device (reserved for use when device is connected). Although it may be possible to successfully connect via a port marked “in use”, this might cause a device or software program to malfunction – proceed at your own risk! Sun Nuclear is not responsible for any damage to your computer as a result of selecting a com port labeled “in use”.

9. Click OK to Com port selection then close Advanced Settings window.

10. In Com Port properties window, click OK.

11. Close all other windows opened using ‘Device Manager’.

12. Return to Set COM Port in Radon Monitor Software procedure on page 11 and select the same Com Port number you selected in Step 7 of this procedure.

**Removing USB to Serial Adapter Drivers**

To reinstall the drivers or to change to a different device, it may be possible to remove the installed drivers via a software process. Refer to the manufacturer’s instructions for details.
Contacting Sun Nuclear Support

Visit the Sun Nuclear Radon website, http://support.sunnuclear.com/radon for links to product information, including instructional videos and Radon FAQs, Calibration and Repair services, online RMA form, Support, Downloads and useful links.

To view product information or to download product assets, click the links under Radon Downloads.

If you need additional assistance, you may request support in two ways:
• Customers without a current support/maintenance agreement can submit a support request using our online form, or visit our FAQ’s page on the same website, http://support.sunnuclear.com/radon.
• Customers with a current support/maintenance agreement also have the option to contact the Sun Nuclear Support team by telephone: +1 321-259-6862.

Support Website

Visit the Sun Nuclear Support website to request support via an online form.

1 Open an internet browser and navigate to https://support.sunnuclear.com/radon.

2 In the left panel, click Contact Support.

3 To open a new support case, click the New Case form link, enter your email address and the serial number of any Sun Nuclear instrument used at your facility, then click Log in to open the Support Dashboard.

Warranty

The Sun Nuclear Product Warranty can be found on the Sun Nuclear Radon Support website, https://support.sunnuclear.com/radon.
Model 1027

Figure 6-1 describes the Model 1027 connectors, controls and indicators.
<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PRINTER PORT</td>
<td>Port is for legacy printer (Model 020030), an accessory for early Model 1027 radon monitors. Current printer connects to DATA port.</td>
</tr>
<tr>
<td>2</td>
<td>DATA PORT</td>
<td>RS-232 data port provides a way to transfer information from Model 1027 to a laptop or personal computer. The information transferred is identical to that sent through the printer port. (See Set Up Communication on page 5.)</td>
</tr>
<tr>
<td>3</td>
<td>BATTERY ON-OFF</td>
<td>Switch connects and disconnects the battery. When ON, the battery powers Model 1027 whenever mains power is not available. When OFF, the battery does not power Model 1027 when mains power is disconnected. Switch should be in the OFF position when Model 1027 is not deployed for a test. This is important for two reasons: first, battery life will be reduced, and second, Model 1027 will continue acquiring measurements as long as battery power is available, which could inadvertently affect the results of a recent test. A fresh battery provides about 20 hours of backup power if mains power fails.</td>
</tr>
<tr>
<td>4</td>
<td>TOP PANEL-ENABLE/DISABLE</td>
<td>Key switch enables and disables digital display and buttons on Model 1027 top panel. When in DISABLE position, Model 1027’s measurement performance is not affected. Model 1027 will function effectively in either key position. This feature is designed to mitigate the temptation to tamper with a test.</td>
</tr>
<tr>
<td>5</td>
<td>DISPLAY</td>
<td>3-digit LED display. Three decimal points display when AVG or CUR is pressed after memory is cleared.</td>
</tr>
<tr>
<td>6</td>
<td>pCi/l</td>
<td>Picocuries per liter – the units of radon gas concentration shown on the display.</td>
</tr>
<tr>
<td>7</td>
<td>AVG</td>
<td>When pressed, the measured long-term average radon gas concentration in pCi/l is displayed on the 3-digit display. This is the cumulative average of the entire period since the memory was last cleared. This value is not lost if the Model 1027 loses all power.</td>
</tr>
<tr>
<td>8</td>
<td>CUR</td>
<td>When pressed, the measured short-term radon gas concentration is displayed. This is a rolling average of the most recent 12 hours. This value is lost if the Model 1027 loses power.</td>
</tr>
<tr>
<td>9</td>
<td>PRINT or CLEAR</td>
<td>Function as PRINT and CLEAR buttons only when yellow LED is flashing. To access this mode, hold both buttons down until yellow LED turns on. Then release buttons, and yellow LED begins to flash.</td>
</tr>
<tr>
<td>10</td>
<td>CLEAR</td>
<td>Yellow LED must be flashing: When pressed, yellow LED turns off. Hold down until yellow LED turns on again; then release. Yellow LED and display LEDs flash once followed by a single flash of yellow LED. Model 1027 memory is cleared. Disturbance switch is inactive for the next 15 seconds.</td>
</tr>
<tr>
<td>11</td>
<td>PRINT</td>
<td>Yellow LED must be flashing: When pressed, Model 1027 sends a report of the data contained in memory to PRINTER and DATA ports. When button is pressed, yellow LED turns on. When released, LED turns off and data transfer begins. When data transfer is complete, yellow LED flashes once.</td>
</tr>
</tbody>
</table>
Figure 6-1. Connectors, Controls, and Indicators

Table 2. Thermal Printer Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green POWER</td>
<td>• Flashing 1x/sec. – power on.</td>
</tr>
<tr>
<td></td>
<td>• Flashing 1x/5 sec.– battery low.</td>
</tr>
<tr>
<td>Green ON LINE</td>
<td>• Flashing – there is data in buffer memory when switch is toggled to OFF LINE.</td>
</tr>
<tr>
<td>Red OFF LINE</td>
<td>• On steady – Paper feed possible.</td>
</tr>
<tr>
<td></td>
<td>• Flashing – paper is not set or has run out.</td>
</tr>
<tr>
<td>Green ON LINE Red OFF LINE</td>
<td>Both flashing – there is an error.</td>
</tr>
</tbody>
</table>
### Table 3. Radon Monitor Report Information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable Info          | • Mark this checkbox if you want the information to appear in the report.  
                         • Clear this checkbox if you want none of the information to appear in the report.                                                   |
| Monitor S/Ns         | Enter the serial number for each Model 1027 you are using, and click the down arrow to place the serial number in the list.  
                         • Prior to transferring a report to your computer, double-click the serial number you want to appear in the Radon Monitor S/N box.  
                         • To remove a serial number from the list, click on it and then click Delete.                                                          |
| Header Info          | Enter text to appear at top of report.                                                                                                                                                                 |
| Start Date/Start Time| Select date and time test started.                                                                                                                                                                      |
| End Date/End Time    | Select date and time test ended.                                                                                                                                                                       |
| Radon Monitor S/N    | In S/N list, double-click serial number of Model 1027 used in test to select it.                                                                                                                     |
| Location             | Enter location of Model 1027 during the test.                                                                                                                                                           |
| Footer Info          | Enter text to appear at bottom of report.                                                                                                                                                              |
| Date boxes (Figure 6-2) | • Use drop down arrow to open a calendar, then scroll to desired month and double-click desired date. Selected date appears in Date box.  
                           • Alternately, type date directly in box, or highlight month, day or year and increment or decrement value using up/down arrow keys. |
| Time boxes           | • Type in times desired, or  
                           • Highlight hours, minutes, or seconds and click arrows to increment or decrement selected value.                                                                                     |

*Figure 6-2. Information Setup Calendar Feature*
The U.S. Environmental Protection Agency (EPA) maintains a comprehensive website on radon at https://www.epa.gov/radon where you can find EPA documents, brochures, and publications relating to radon.

Below are descriptions of three EPA publications on radon, listed on the EPA’s publications website, https://www.epa.gov/radon/publications-about-radon.

- **A Citizen’s Guide to Radon: The Guide to Protecting Yourself and Your Family from Radon**
  This guidance offers strategies for testing your home for radon and discussions of what steps to take after you have tested, as well as discussions about the risk of radon and radon myths.

- **Consumer’s Guide to Radon Reduction: How to Fix Your Home**
  This booklet is for people who have tested their home for radon and confirmed that they have elevated radon levels. This booklet can help with selecting a qualified contractor to reduce the radon levels in the home, determining an appropriate radon reduction method, and maintaining a radon reduction system.

- **Home Buyer’s and Seller’s Guide to Radon**
  This booklet is intended for anyone who is buying or selling a home, real estate and relocation professionals, home inspectors and others.
## 7 Specifications

### Recommended System Requirements

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 10, Windows 8.1, or Windows 7</td>
</tr>
</tbody>
</table>
| Computer           | Minimum  
|                    | • Processor: x486  
|                    | • Total RAM: 32 MB  
|                    | • Hard disk space: 5 MB  
|                    | • USB port: one  
|                    | • Display resolution: 1024 x 768  
|                    | • Color depth: 32-bit |

### Model 1027 Specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supply</td>
<td>Converter, 120 VAC to 12 VDC, 200 mA, 60 Hz</td>
</tr>
<tr>
<td>Measurement Range ()</td>
<td>0.1 to 999 pCi/l or 1 becquerel per cubic meter (Bq/m³) to 99.99 kilo becquerels per cubic meter (kBq/m³)</td>
</tr>
<tr>
<td>Accuracy</td>
<td>±25% or 1 pCi/l, whichever is greater after 24 hours</td>
</tr>
<tr>
<td>Disturbance Sensor</td>
<td>Inertial switch</td>
</tr>
<tr>
<td>Data Port</td>
<td>RS-232, 9-pin, D-connector allows printer data to be sent to PC</td>
</tr>
<tr>
<td>Detector</td>
<td>Diffused-junction photodiode</td>
</tr>
<tr>
<td>Measurement Interval</td>
<td>1 hour (4, 8, or 24-hour intervals available by special order)</td>
</tr>
<tr>
<td>Sensitivity (counts per hour/pCi/l)</td>
<td>2.5</td>
</tr>
<tr>
<td>Display</td>
<td>3-digit display LED</td>
</tr>
<tr>
<td>Battery Backup</td>
<td>One 9V alkaline battery supplies approximately 20 hours of operation. LED indicates low battery.</td>
</tr>
<tr>
<td>Weight (kg / lbs.)</td>
<td>0.91 (2.0)</td>
</tr>
<tr>
<td>Dimensions (mm / in.)</td>
<td>203 x 119 x 63.5 (8 x 4.7 x 2.5)</td>
</tr>
</tbody>
</table>
| Operating Environment        | 7 to 35 °C (45 to 95 °F)  
|                              | 20 to 80% relative humidity, non-condensing |
| Storage Environment          | −30 to 50 °C −22 to 122 °F ()  
|                              | 10 to 90% relative humidity, non-condensing |
| Regulatory Evaluation        | National Radon Safety Board (NRSB); Device code: 31807; Group Code: CR.  
|                              | National Environmental Health Association National Radon Proficiency Program (NEHA-NRPP); Device Code 223; Group Code 4. |
Appendix A: Regulatory Supplement

Sun Nuclear Corporation Symbols

The following symbols are used in this guide and in Sun Nuclear Corporation’s product labels.

**WARNING:** This symbol indicates a risk of electric shock.

**WARNING:** This symbol indicates a hazard that could result in major injury or equipment damage.

**CAUTION:** This symbol indicates a potential hazard that could result in a minor injury or equipment damage.

**CAUTION:** No activated mobile phone.

Important or supporting information.

Manufacturer’s Identification (name and address).

Date of Manufacture.

Serial Number.

Catalog Number.

Consult instructions for use. This equipment must be used in accordance with the instructions in this manual. Read all instructions and safety labels before use.
Operator Responsibility

This guide is intended for an operator who is experienced with the use of radon detection devices. The operator of the device bears the full responsibility for validating measurement results. The device and its accessories must not be used for any other purpose than described in this guide. Violation will result in loss of warranty.

Reporting Health or Safety Related Issues or Concerns

Should the need arise to report any safety or health related issues or concerns regarding the use of Sun Nuclear products, contact Sun Nuclear Support. See Contacting Sun Nuclear Support on page 28.

Modifications to Equipment

Any changes or modifications to the instrument that are not expressly approved by Sun Nuclear Corporation could void your warranty.

Interaction with Other Electrical Equipment

The instrument can only be connected to external computer equipment that is compliant with IEC 60950-1, Safety of Information Technology Equipment.